Creating a part in Pro/ENGINEER:

Select the FILE menu at the top of the screen and then select the option NEW

Select the button for PART (if it is not already selected) and enter a name for the file in the space provided.
This will create a set of three mutually-orthogonal datum planes and display them on the screen. They are labeled RIGHT, TOP, and FRONT.

A few comments on Datum Planes; Datum planes are 2-sided. They have a Yellow side and a Red side. The yellow side is considered primary, that is, in most commands involving orientation of the datum plane in 3D space, the facing of the yellow side takes precedence.

To create your first shape feature:

From the Feature menu select CREATE
For Feature Type select SOLID and in the SolidType menu, select PROTRUSION (a protrusion is a solid feature which adds material to the model)

For SolidOptions select EXTRUDE, SOLID and DONE

This specifies that we will be creating our protrusion using the operation of extrusion, which sweeps a planar profile through a distance normal to the plane of the profile.

The FeatureControl dialogue box will now open and show what is required to create the feature in question. The box lists the properties for the feature and notes whether they have been defined, are currently being defined, or are still required.

For Attributes select One Side and Done (this option specifies that we will extrude to one side of the plane of the profile; the two side option makes the profile plane the midplane of the feature)

The next step is to define a sketch plane. This is the plane on which the extrusion profile will be sketched. We will use one of the three Datum Planes already created.

In the Get Select window choose Query Select and select TOP (you can pick anywhere on its border or on the label). The datum plane will be highlighted. Press the middle mouse button to confirm your selection.

An arrow will be displayed showing the direction for feature construction. This is the direction that the profile will be extruded. You may flip the direction if desired. Select
OK to continue.

The next step is to select a horizontal or vertical reference for the sketch plane. When sketching the profile we will be viewing the sketch plane (in our case, TOP) along a line of sight normal to that plane. However, we must orient the sketch plane as to which direction within the plane is horizontal and which is vertical. Perhaps the easiest way to think of this is as follows. We will be sketching on the "yellow side" of TOP and hence viewing that side. When we view the "yellow side" of TOP the "yellow side" of one of the other two datum planes (either RIGHT or FRONT) will face the top, bottom, left side or right side of the screen.

Select **Right** from the menu, **Query Select**, and then choose **RIGHT** and the MMB to end.

The screen display changes and we see the plane view of **TOP**. We are now in **Sketcher Mode**. This where the creation of the shape profile for our first feature will be made. You will notice the grid overlaying the display. This is to assist you in drawing your profile.

The Sketcher menu is now open. The default selection is **Mouse Sketch**. When the Mouse Sketch option is selected, the mouse buttons function as follows:

- **LMB** pick line endpoint or cancel circle input
- **MMB** pick circle center and drag radius or cancel line input
- **RMB** pick tangent arc endpoints*

* tangent at start point only, first pick must an be existing entity

Using the **Mouse Sketch** line options (**LMB** to pick, **MMB** to end), sketch the outline (or profile) of the part base on **TOP**. Use the guidelines to help you. While absolute accuracy is not critical, your profile should approximately correct. When completed, your profile should appear similar to the one at right.

The next step is to provide the necessary constraints to restrict our sketched profile to represent a single shape. In this exercise we will accomplish this by applying dimensional constraints to the profile. These constraints will be in the form of actual dimensions. The value assigned to the dimensions is variable and can therefore be used to alter the profile.
Dimensions can be linear (distance between two parallel line, perpendicular distance between a line a point, distance between two points), angular (angle between two non-parallel lines), diametric or radial.

For the first profile of our part, we will need only linear dimensions. First we will constrain the overall size of the base. To create the dimension for the overall height, first go to the SKETCHER menu and select Dimension. Next pick the top horizontal line, then the bottom horizontal line (they will be highlighted) then move the mouse to the right of the profile and press the MMB. For the overall width, pick the two vertical lines and move the mouse above the profile and pick the MMB. Your profile should look similar to the one at right.

Notice that the dimensions do not have values but rather a label will be displayed. We will assign exact values at a later step.

Next we will assign values for the inclined edges of the profile. First the horizontal dimension. While still in the Dimension command, select the left endpoint of the lower inclined line. Next select the right hand vertical line. Finally, move the mouse to a point below the inclined line and press the MMB. To create the vertical dimension, select the right endpoint of the same inclined line, then the lower vertical line, move the mouse to the right of the inclined line and press the MMB.

*If we were careful in sketching the initial profile shape, the software will assume that the same dimensions apply to the inclined feature at the top. If not, we must repeat the previous process to dimension this shape on the other side.*
In Pro/ENGINEER, all features created must be located with respect to the existing part. In our case, the feature we are creating (the shape of the base), must be located to our part. So far, the only features in our part are the 3 datum planes, so we must locate our profile with respect to these. Only a line view of a datum plane may be used for dimensioning purposes, so we can create a horizontal dimension to RIGHT and a vertical dimension to FRONT. Pick the left side vertical line of the profile and then pick RIGHT (anywhere along its length). Move the mouse above the profile and press the MMB. Pick the top horizontal line of the profile and then pick FRONT. Move the mouse to the right of the profile and press the MMB.

We can now apply our dimensional constraints to the profile to ensure that we have sufficient dimensions to fully the profile and produce a single resultant shape. The process is similar to fully dimensioning a geometric shape as you learned in your engineering graphics class. To apply the constraints, go to the SKETCHER menu and select Regenerate. If your profile is under-constrained (too few dimensions) you will be notified at this point and will have to rectify the condition before proceeding. If your have provided sufficient dimensions, the profile will update in shape and the current values assigned to the dimensions will be displayed.

To change the values of your dimensions, go to the SKETCHER menu and select Modify (if not already selected by default). Select the dimension to change by picking directly on the dimension value. Enter the new value at the keyboard and either press the Enter key or pick the Green Check Mark at the right side of the input window to continue. Notice that the dimension value will turn white. This indicates that a change has been made but not evaluated yet. Continue this process until all values have been modified to agree with those on the part drawing at the beginning of this tutorial. For the horizontal and vertical locating dimensions (those to RIGHT and FRONT) use the following value. Set the horizontal dimension to 1.875 and the vertical to 2.125.

When all dimension values have been updated, select Regenerate to apply the new values to the profile shape and see the effect.

We are now ready to continue with construction of the feature. Select Done from the bottom of the SKETCHER window. Next go to the VIEW menu at the top of the screen and select Default.
The view will appear as at right. The next step is to define the distance of the extrusion process. The arrow shown indicates the direction for the extrusion.

The open dialogue lists the options for the extrusion distance. The default is **Blind**. A blind extrusion is one with a set value for the distance. Select the option **Blind** and then **Done**. Enter the value 1.00 at the keyboard and either press the **Enter** key or pick the **Green Check Mark** at the right side of the input window to continue.

We can now proceed with the creation of the extruded feature. In doing so we will use the **FeatureControl** dialogue box introduced earlier.

We can see from the **FeatureControl** dialogue listing that all elements for the feature have been successfully defined. At this point we can preview our geometry to verify that our construction is correct. Select the option **Preview** from the **FeatureControl** dialogue.

This will generate a preview image of the feature as specified by our current element settings. The preview geometry will appear in red. If we wish to make a change in the feature's specifications, we can do so now. For example, to change the extrusion **Depth**, move the mouse pointer to the listing in the dialogue box for **Depth** and pick (it will be highlighted). Select the button marked **Define** and you will return to the point in feature construction where you originally specified depth. You are now able to change the value and proceed as you did previously.

The **FeatureControl** dialogue will allow to "roll back the clock" to any point in the construction process after you specified the construction technique.
(extrusion in our case). You can change which plane the sketch is on using the **Section** option, or the direction in which the feature is extruded with the **Direction** option. Again, you can **Preview** after any change to verify the geometry.

Once you have the feature's specifications finalized, select **OK** to construct the feature and continue.

The next step will be to construct the upright portion of the part. To do this we will have to attach our sketch plane to the rectangular surface on the far left of the object as viewed above.

The **Feature** menu will be open. **Select** the option **Create** (to create a new feature), **FeatureClass Solid**, and then from the **Solid** menu pick **Protrusion** (again, we are adding material to the part). Our **SolidOptions** should be **Extrude**, **Solid** and **Done**.

We will see the **FeatureControl** window and will proceed as we did before, setting the feature specifications and defining a sketch plane. From the **Attributes** menu select **OneSide**.

Next we define the sketch plane. Select **Query Select** for the **Get Select** menu. Move the mouse to a near the left side of the top surface (as shown) and pick. The top surface will be highlighted but we want the hidden surface to the left. From the **Query_Bin** dialogue pick the other, non-highlighted surface name. The desired surface should be highlighted. Select **Accept** to continue.

We wish the direction arrow to point to the right as we view the part, so from the **Direction** menu select **Flip** and then **OK**.

Next we will orient the sketch plane. From the **Sket View** menu select **Top** and then **Query Select**, pick **TOP** and press the **MMB** to confirm the selection. This setting
means that as we view the sketch plane the Yellow side of TOP will face the top of the display screen.

We will now be back in Sketch Mode and our view should look approximately the same as that to the right.

Since the sketch will be to the top of the current feature, we may wish to Pan our display. To do this move the mouse pointer to the center of the Sketcher screen, press and hold the CTRL key, then press the RMB and drag toward the bottom of the screen.

Start the sketch by moving the mouse to a point above the first feature and in line with FRONT. Press the MMB and drag out circle. Press the MMB again to set the diameter. The sketch shape should appear as shown to the right.

Next we will create the lines from the corners of the first feature, which then meet the circle at tangent points. Go to the Sketch menu and select Line. In the Line Type menu select Pnt/Tangent.
Pick the upper left-hand corner of the rectangular view of the first feature and then pick the left side of the circle just created. The pick point on the circle does not have to be at the point of tangency, anywhere of the left-hand half of the circle will work. Repeat the process for the line on the right-hand side. The sketch should appear as shown below.

Next we will need to remove the lower portion of the circle. To do this we must divide the circle into two segments with the segment endpoints at the tangent intersections with the lines we just drew.

From the Sketcher menu select Geom_Tools. From the Geom_Tools menu select Intersect. Pick the left-hand line and then pick the left side of the circle. This will "break" the circle at the intersection point. Repeat the process using the right-hand line. The circle will now be divided into two arcs and we can delete the lower half. Select Delete from the Sketcher menu and pick the lower half of the circle.

Next we will add the dimensional constraints to this new profile and modify the values to agree with our part specifications.

To dimension the arc, go to the Sketcher menu and select Dimension. Pick the arc with the LMB and then move to space below and to the left of the arc and press the MMB.

To apply the vertical location dimension for the arc, pick the center
point of the arc and then the bottom edge of the first feature (this is the plane of TOP). Move the mouse to the right of the profile and press the MMB.

Next we will constrain the center of the arc to lie along the centerline of the part. We will do this by aligning the center of the arc with FRONT. Go to the Sketcher menu and select Alignment. Pick the center point of the arc and then FRONT. Your should see a response in the message window of "Aligned" and see a dashed line on screen indicating the alignment.

Next we align the lower endpoints of the tangent lines we drew to lie at the corner of the first feature. While still in the Alignment command, pick the lower endpoint of the left-hand line and then pick the upper horizontal line of the first feature. Repeat and align the endpoint of the left-hand line to left-hand vertical edge of the first feature. Again, dashed lines will appear to indicate the alignment. Repeat the process for the right-hand line.

Our profile should now be fully constrained. Select Regenerate from the Sketcher menu. Now we modify the dimension values. Select Modify and then pick the value of the arc radius. Set the value to 1.25. Select the value of the vertical dimension and set the value to 2.625. Select Regenerate.

Go to the View menu at the top of the screen and select Default.

Select Done from the bottom of the Sketcher menu.

Arrow will display on screen pointing to one side of the profile of the other. Note that the prompt in the message window says "arrow points TOWARD area to be added". This means that the material added by the protrusion will be to the indicated side of the profile. For our example the arrow should point inward. Flip, if required and then pick OK.

Next we are prompted for the feature construction direction and the distance of the extrusion. The arrow should point toward the right in our default view. Select option Blind and then Done. Enter the .750 at the keyboard and press the Enter key. Select Preview in the FeatureControl window and then, if correct select OK.
The next step will be to construct the small feature on the top surface of the base. To do this we will have to attach our sketch plane to the top surface of the base feature as viewed above.

The **Feature** menu will be open. **Select** the option **Create** (to create a new feature), **FeatureClass Solid**, and then from the **Solid** menu pick **Protrusion** (again, we are adding material to the part). Our **SolidOptions** should be **Extrude, Solid and Done**.

We will see the **FeatureControl** window and will proceed as we did before, setting the feature specifications and defining a sketch plane. From the **Attributes** menu select **OneSide**.

Next we define the sketch plane. **Select Query Select** for the **Get Select** menu. Move the mouse to a near the left side of the top surface of the base (as shown) and pick. The top surface will be highlighted. **Select Accept** to continue.

We wish the direction arrow to point outward as we view the part, so select **OK**.

Next we will orient the sketch plane. From the **Sket View** menu select **Bottom** and then **Query Select**, pick **RIGHT** and press the **MMB** to confirm the selection. This setting means that as we view the sketch plane the Yellow side of **RIGHT** will face the bottom of the display screen.

We will now be back in **Sketch Mode** and our view should look approximately the same as that to the right.
The shape of our next feature profile is a rectangle. This can be easily created. From the Sketch > Geometry menu selection, Rectangle. This command allows you to create the four lines of a rectangle by defining the diagonally opposite corners of the rectangle.

Create the rectangle such that it is centered over FRONT with its upper edge coincidental with the front edge of the upright feature and its lower edge coincidental with the lower edge of the part, as shown in the adjacent view. If you make a mistake in selecting the starting point, you can start over by reselecting the Rectangle command.

To constrain our profile we will need two horizontal dimensions to specify the width of the rectangle and to center it on the part. Vertical size and location will be accomplished by aligning the rectangle to existing edges of the part.

Select Dimension from the Sketcher menu. Pick the two vertical sides of the rectangle we just drew then move the mouse to a position below the profile and press the MMB. Select the left-hand vertical line of the rectangle and the line view of FRONT. Move the mouse to a position above the part and press the MMB.

Select Alignment from the Sketcher menu. Pick the upper line of the rectangle and the object edge it is draw on top of. Pick the lower line of the rectangle and the bottom object edge. Again, dashed lines will indicate alignment.

Select Regenerate from the Sketcher menu. Now we modify the dimension values. Select Modify and then pick the value rectangle width dimension. Set the value to .750. Select the value of the horizontal-locating dimension and set the value to .375. Select Regenerate.
Go to the **View** menu at the top of the screen and select **Default**.

Select **Done** from the bottom of the **Sketcher** menu.

Next we are prompted for the feature construction direction and the distance of the extrusion. The arrow should point toward the top of the screen in our default view. Select option **Blind** and then **Done**. Enter the value .250 at the keyboard and press the **Enter** key. Select **Preview** in the **FeatureControl** window and then, if correct select **OK**.

We will next create the single hole through the upright feature. Pro/ENGINEER provides a special feature type for the construction of holes. The hole feature will be located coaxial to the axis of the radius in the upright feature. Since no axis is displayed, we must first create one.

In the **Part** menu select **FEATURE**

In the **Feature** menu select **CREATE**

For **FeatureType** select **DATUM** and for **Datum Option** select **Axis**

In the Datum Axis window select Thru Cyl and then in the Get Select menu pick Query Select. Pick the curve surface at the top of the object and then press the **MMB** to confirm the selection. An axis should be created and labeled A_1.

Now we will create the hole coaxial with axis A_1.
In the Feature menu select Create. For FeatureType select Hole. You are now in the hole feature construction sequence and the HoleConstruction dialogue box is open.

In the top section of the Hole dialogue box, select Straight. This option creates a straight walled hole, such as a drilled or bored hole.

Next, we must enter the hole diameter. Pick the Diameter input window in the Hole dialogue and enter .75 at the keyboard. Press the Enter key.

Next option is for the termination of the hole. This particular holes passes all the way through the part so in the Depth One window pick Thru All.

Next we must specify the Primary Reference. This is the surface to which the hole is mounted. Think of it as the surface you would start drilling through.

Select option Query Select from the Get Select menu. Next pick the surface where the hole will attach (anywhere within its area) and press the MMB to confirm the selection.

The next specification is how to locate the hole on its mounting face or plane. This is referred to as Placement Type. For this example we will choose Coaxial since the hole will be coaxial to the axis we just created. We now need to select the axis. Select option Select By Menu from the Get Select menu and pick the axis A_1 from the list. Select Done to end the entry.

To preview your hole, select the “Sunglasses” icon at the bottom of the HoleConstruction dialogue box. To create the feature, select the Green Check.
The last step is to create the two counterbored holes in the base of the part. We will create one hole feature then pattern it to create the second.

In the Feature menu select Create. For FeatureType select Hole.

In the top section of the Hole dialogue box, select Sketched. This option is used for holes with a shape more complicated than those that are simply drilled. Examples are counterbored and countersunk holes.

A sketch window will now open. We must sketch and constrain the profile of the hole. The hole feature will be created by taking the sketched profile and revolving it 360 degrees. Because of this we need only sketch half of the profile. Sketch the profile as shown.

Since the profile is to be revolved, an axis of revolution will be needed. This will created as a sketch entity. To create the axis select Line from the Geometry menu, then Center Line and Two Points. Sketch the centerline coincidental with the right-hand edge of the profile and extending beyond the endpoints of the edge on both ends.

Holes are normally dimensioned as diameters. To specify the diameter of the hole we will use a dimensioning trick.

First we will dimension the counterbore diameter. Select Dimension from the Sketcher menu. Pick the far left-hand vertical edge of the profile. Next select the centerline we just created. (we made it longer than the edge to make this selection easier) Now pick the far left-hand edge again for a total of three picks. Move the mouse pointer to a position above the profile and press the MMB.

To dimension the drill diameter, repeat this process using the other vertical edge. Remember to pick the edge, the centerline, then the edge again and finally place with the MMB.
Using the techniques we have previously learned, dimension the counterbore depth and overall depth.

Select **Regenerate** from the **Sketcher** menu.

Now we modify the dimension values. Select **Modify** change the dimensions to agree with the part drawing. The counterbore diameter is 1.000, the drill diameter .625, the counterbore depth is .250 and the total depth is 1.000. Select **Regenerate** and then **Done**.

Next we must specify the **Primary Reference**. Use **Query Select** and pick the plane for the hole on the left. Try to pick the approximate location where you would like the center of the hole. Press the **MMB** to confirm the selection.

The next specification is how to locate the hole on its mounting face or plane. In the **Placement Type** entry window choose **Linear**. Next we select the edges from which to locate the hole. Pick the two edges shown in the view to the right. After each selection you must enter the value of the dimension from the edge selected. The dimensional values are .875 from the side edge and 1.875 from the front.

**Preview** and **Create** the hole as shown previously.

Finally we will pattern the first counterbored hole to create the second. In the Feature menu select **Pattern**.

You are now prompted for the feature to be patterned. Select option **Query Select** from the **Get Select** menu. Next the inner surface of the counterbored and press the **MMB** to confirm the selection.

From the **Pattern Options** menu select **Identical** and **Done**.
All the dimensions which define the feature to be patterned (the counterbored hole) will be displayed. You are prompted to select the dimension for the first direction of the pattern. This is the direction the pattern will build in. Because of where we want the next hole, we want to select the .875 linear dimension.

For the **Dimension Increment** use the distance between the two holes (2.500). Enter this vale at the keyboard. Select **Done** from the open menu. For the total number of instances enter 2 at the keyboard. ("instance" is another term for copy)

Select **Done** from the open menu. The second hole will be created. To view a rendered image of the part, go to the View menu at the top of the screen and select **Shade**. To remove the shading, go to the View menu and select **Repaint**. To dynamically alter your viewing line-of-sight, move the mouse pointer to the center of the screen, press and hold the CTRL key, press and hold the MMB and then move the mouse.